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Miért kell lépcsőzetesen végezni az elemzést, miért 
nem lehet egyetlen ANOVA-táblázatból dönteni?

Minden lépésnél új vizsgálatot kezdtünk, új ANOVA-táblázatot
számoltunk, és csak egy összehasonlítást használtunk!

ld. külön lapon

Az egymás után következő vizsgálatok Error négyzetösszege és 
szabadsági foka növekszik.

A Time négyzetösszege és szabadsági foka változatlan.
A Batchn négyzetösszege és szabadsági foka különbözik.
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Az alapértelmezett négyzetösszeg-típus: „Effective hypothesis
decomposition”
A választék:
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Type VI: H0: a vizsgált hatás modellbe vétele nem javítja a 
leírást (nem csökkenti szignifikánsan a maradék 
négyzetösszeget),  feltéve, hogy az összes többi tag már 
benne van a modellben.

Type I (szekvenciális)  
a modellt a tagok egyenkénti bevonásával építjük föl
H0: a vizsgált hatás modellbe vétele nem javítja a leírást, 
feltéve, hogy a fölötte lévők már benne vannak a modellben.

ld. a külön lapon

( ) ( ) ijkijiijiijk xxy εβββααα +−++−+=

Intercept Batchn Time     Batchn*Time
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Type I esetén

Az egyes hatásokhoz tartozó négyzetösszegek azonosak, nem 
változnak, ha lépcsőzetesen további tagokat veszünk a modellbe.
Ha elhagyunk tagokat a modellből, azok négyzetösszege és 
szabadsági foka az Error tagba kerül.

Az F0 próbastatisztika értéke a megfelelő tagokra nem pontosan 
azonos az egyes elemzéseknél, mert az Error négyzetösszeg más.

Az egyes elemzési lépésekben vizsgált hatásokra ugyanazt az 
eredményt kapjuk (F0-ra és p-re), mint a szimultán (Type VI.) 
vizsgálatnál, ha csak a kérdéses sort nézzük.

A legelső (a Homogeneity-of-slopes elemzésnél kapott) 
ANOVA-táblázatból az összes döntéseket meghozhatjuk, ezek 
csak kétséges (p≈0.05) esetben finomítandók.
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Univariate Results for Each DV (Lin1.sta)
Sigma-restricted parameterization
Type I decomposition

Effect
Degr. of
Freedom

Concent
SS

Concent
MS

Concent
F

Concent
p

Intercept
Time
Batchn
Batchn*Time
Error
Total

1 208801.71 208801.71 103384.76 0.000000
1 11.70 11.70 5.80 0.029401
2 1.14 0.57 0.28 0.757503
2 1.14 0.57 0.28 0.757352

15 30.29 2.02
20 44.29

Univariate Results for Each DV (Lin1.sta)
Sigma-restricted parameterization
Type I decomposition

Effect
Degr. of
Freedom

Concent
SS

Concent
MS

Concent
F

Concent
p

Intercept
Time
Error
Total

1 208801.71 208801.71 121763.72 0.000000
1 11.70 11.70 6.83 0.017120

19 32.58 1.71
20 44.29

Univariate Results for Each DV (Lin1.sta)
Sigma-restricted parameterization
Type I decomposition

Effect
Degr. of
Freedom

Concent
SS

Concent
MS

Concent
F

Concent
p

Intercept
Time
Batchn
Error
Total

1 208801.71 208801.71 112906.92 0.000000
1 11.70 11.70 6.33 0.022220
2 1.14 0.57 0.31 0.738223

17 31.44 1.85
20 44.29
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Time 
(month) 

Batch 1 Batch 2 Batch 3 

0 105.4 101.8 105.1 
4   104.5 
8   103.6 
13   104.9 
26   106.3 
39 102.8 99.9  
52 103.1 101 104.5 
78 102.8 99.2 103.7 
104 102.2 99.1  
 

3. példa: A sarzsok egyesíthetőségének vizsgálata

Lin2_MD.sta 

nem kiegyensúlyozott terv
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Scatterplot of Concentr against Time

Lin2_MD.sta 3v*17c

 Include Batchn=1 
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 Include Batchn=3 
 Other 
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Statistics>Advanced Linear/Nonlinear Models>General Linear Models>
Homogeneity of slopes
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Döntés?

Options fülön: Type I
Quick fülön: All effects

DC SSSS −

Univariate Tests of Significance for Concentr (Lin2.sta)
Sigma-restricted parameterization
Type I decomposition

Effect
SS Degr. of

Freedom
MS F p

Intercept
Time
Batchn
Batchn*Time
Error

180126.471 1 180126.47 273518.9 0.000000
25.346 1 25.35 38.5 0.000067
41.649 2 20.82 31.6 0.000027
1.140 2 0.57 0.9 0.447651
7.244 11 0.66
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Statistics>Advanced Linear/Nonlinear Models>General Linear
Models>General Linear Model

Megváltoztatjuk a tagok 
sorrendjét
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Statistics>Advanced Linear/Nonlinear Models>General Linear Models>
Analysis of Covariance
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Quick fülön: All effects
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Univariate Tests of Significance for Concentr (Lin2.sta)
Sigma-restricted parameterization
Type I decomposition

Effect
SS Degr. of

Freedom
MS F p

Intercept
Time
Batchn
Error

180126.471 1 180126.47 279300.9 0.000000
25.346 1 25.35 39.3 0.000029
41.649 2 20.82 32.3 0.000009
8.384 13 0.64
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Az adatok részben egyesíthetők (párhuzamos egyenesek: C 
modell).

Előnye: a degradálódási egyenes meredekségét több adatból 
pontosabban becsülve szűkebb konfidencia-sávot, s így 
hosszabb becsült eltarthatósági időt kapunk.

Ellenőrizzük a modell alkalmasságát a reziduumok
ábrázolásával!
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Normal Prob. Plot; Raw Residuals

Dependent v ariable: Concentr

(Analy sis sample)
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Közös meredekség, egyedi tengelymetszet:
minden sarzsra külön-külön ki kell számítani az eltarthatósági 
időt, a legrövidebb lesz az összes sarzsra elfogadott becsült 
eltarthatósági idő. 

95%-os egyoldali (90%-os kétoldali) konfidenca-sáv a legalul futó
egyenesre

Statistics>Advanced Linear/Nonlinear Models>General Linear
Models>Analysis of Covariance
Dependent: Concent
Categorical pred.: Batchn
Continuous pred.: Time
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Summary fülön: Confidence 0.9
Resids fülön: a Predicted and residuals gomb melletti Extended
stats négyzetbe tegyünk pipát, és kattintsunk a Savegombra. 
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Lin2_MD.sta
1

Time
2

Batchn
3

Concentr
4

ConcOBS1
5

ConcPRE1
6

ConcRES1
7

ConcSEP1
8

ConcLPI1
9

ConcUPI1
10

ConcLCL1
0.000 1.000 105.400 105.400 104.450 0.950 0.489 102.419 106.482 103.394

39.000 1.000 102.800 102.800 103.600 -0.800 0.371 101.689 105.512 102.798
52.000 1.000 103.100 103.100 103.317 -0.217 0.359 101.416 105.218 102.540
78.000 1.000 102.800 102.800 102.750 0.050 0.386 100.825 104.675 101.915

104.000 1.000 102.200 102.200 102.183 0.017 0.468 100.175 104.191 101.172
0.000 2.000 101.800 101.800 101.390 0.410 0.489 99.359 103.422 100.334

39.000 2.000 99.900 99.900 100.540 -0.640 0.371 98.629 102.452 99.738
52.000 2.000 101.000 101.000 100.257 0.743 0.359 98.356 102.158 99.480
78.000 2.000 99.200 99.200 99.690 -0.490 0.386 97.765 101.615 98.855

104.000 2.000 99.100 99.100 99.123 -0.023 0.468 97.115 101.131 98.112
0.000 3.000 105.100 105.100 105.221 -0.121 0.342 103.335 107.106 104.483
4.000 3.000 104.500 104.500 105.134 -0.634 0.331 103.257 107.010 104.418
8.000 3.000 103.600 103.600 105.046 -1.446 0.322 103.177 106.916 104.350

13.000 3.000 104.900 104.900 104.937 -0.037 0.313 103.075 106.800 104.260
26.000 3.000 106.300 106.300 104.654 1.646 0.304 102.799 106.509 103.998
52.000 3.000 104.500 104.500 104.087 0.413 0.343 102.201 105.973 103.347
78.000 3.000 103.700 103.700 103.520 0.180 0.439 101.543 105.497 102.572

Data>Input Spreadsheet
Scatterplot
Sel>Batchn=2

Time, Batchn, ConcPRE1, ConcLCL1 

Stabilitásvizsgálat 61

Data>Input Spreadsheet
Scatterplot
Sel>Batchn=2

jobb click: 
Graph Properties

Scatterplot of multiple variables against Time

Spreadsheet1 21v*17c

Include condition: Batchn=2

 ConcPRE1
 ConcLCL1
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jobb click: 
Graph Properties

Scatterplot of multiple variables against Time

Spreadsheet38 7v*17c

ConcPRE1 = 101.3904-0.0218*x
ConcLCL1 = Spline

Include condition: Batchn=2

 ConcPRE1
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Extrapoláció

1. Egészítsük ki az adatfile-t azokkal az időpontokkal, amelyekre 
számítást kívánunk végezni: 120, 160 és 200 időegység. 
Ezekben az időpontokban nincs koncentráció-mérési adatunk, tehát a 
megfelelő cellák üresen maradnak. 

Lin2pred.sta

1
Time

2
Batchn

3
Concentr

1

2

3

4

5

6

7

8

9

10
11
12

0 1 105.4

4 1

8 1

13 1

26 1

39 1 102.8

52 1 103.1

78 1 102.8

104 1 102.2

120 1
160 1
200 1

2. Hajtsuk végre a kovariancia-analízist 
3. Számítsuk ki a becsült koncentráció-
értékeket (az illesztett egyenes pontjait) 
és az alsó konfidencia-sáv pontjait

Confidence 0.9
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Summary fülön: Confidence 0.9
More results
Residuals1 fülön:
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Egyesítjük a két Spreadsheet-et.
Data>Merge

Hagyjuk el a fölösleges oszlopokat 
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Scatterplot of multiple variables against Time

Spreadsheet8 4v*36c

Include condition: Batchn=2
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 ConcLCL1
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Scatterplot of multiple variables against Time

Spreadsheet8 4v*36c

Include condition: Batchn=2

 ConcPRE1
 ConcLCL1
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Ha egy-egy időpontban több adatunk van, azokra számoljunk, vagy 
az átlagaikra?

Scatterplot of Y against X

2-Way Tables of Descriptive Statistics (Linreg2.sta) 2v*5c

Y = 0.7375+2.1164*x; 0.95 Conf.Int.
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Scatterplot of Y against X

Linreg2.sta 2v*25c

Y = 0.7375+2.1164*x; 0.95 Conf.Int.
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Nem minden papsajt!

A mérési pontok rendellenes elhelyezkedése

Az időpontok közötti ingadozás figyelembe vétele 

Nemlineáris függvény

Rész-tervek (matrixing és bracketing)

Koncepcionális probléma
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Az időpontok közötti ingadozás figyelembe vétele

"A" batch "B" batch "C" batch
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T.E. Norwood, Drug Development and Industrial Pharmacy, 12 (1986) 553-560
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hónap tárolási idő (j) 
naptári (t) "A" sarzs "B" sarzs "C" sarzs 

0 0   
3 3 0  
6 6 3 0 
9 9 6 3 
12 12 9 6 
18 18 15 12 
24 24 21 18 

 

Korrekciós lehetőség, ha a sarzsok nem egyszerre indulnak

ijiiij xY βα ˆˆˆ += helyett tijiiij xY δβα ˆˆˆˆ ++=
t a naptári idő

K. Komka, S. Kemény: A modified error model for the assessment of stability 
of pharmaceutical products, Chemometrics and Intelligent Laboratory Systems, 

72, 161-165 (2004)
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Nemlineáris degradálódási függvény illesztése

Szerencsés esetben találunk a független változóra olyan 
transzformációt, amelyre a függő változó lineáris lesz.

4. példa
9 sarzs koncentrációjának időbeli változására vannak adataink, 
minden időpontban egy mintával

nemlin_stab.sta
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Graphs>Scatterplots
Advanced fülön Mark selected subsets

Scatterplot of konc against ho

nemlin_stab.sta 3v*45c

 Include sarzs=1 
 Include sarzs=2 
 Include sarzs=3 
 Include sarzs=4 
 Include sarzs=5 
 Include sarzs=6 
 Include sarzs=7 
 Include sarzs=8 
 Include sarzs=9 
 Other 
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formális elemzés: egyeneseket illesztünk

Univariate Tests of Significance for konc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.185474

Effect
SS Degr. of

Freedom
MS F p

Intercept
sarzs
ho
sarzs*ho
Error

144541.91 1 144541.91 30262.32 0.000000
6.33 8 0.79 0.17 0.993763

143.16 1 143.16 29.97 0.000009
71.98 8 9.00 1.88 0.104539

128.96 27 4.78
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ho vs. konc, Resids

(Analysis sample)
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nem illeszthetünk 
egyeneseket

megfelelő transzformáció lehet: a hónapok logaritmusa 
függvényében ábrázoljuk a mért koncentrációkat,
de ln(0)

ln(ho+0.05)
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Scatterplot of konc against lnho
nemlin_stab.sta 4v*45c

 Include sarzs=1 
 Include sarzs=2 
 Include sarzs=3 
 Include sarzs=4 
 Include sarzs=5 
 Include sarzs=6 
 Include sarzs=7 
 Include sarzs=8 
 Include sarzs=9 
 Other 
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Univariate Tests of Significance for konc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.232879

Effect
SS Degr. of

Freedom
MS F p

Intercept
sarzs
lnho
sarzs*lnho
Error

346717.73 1 346717.73 69541.71 0.000000
92.59 8 11.57 2.32 0.048624

178.63 1 178.63 35.83 0.000002
30.86 8 3.86 0.77 0.628936

134.62 27 4.99

az egyenesek meredekségének különbözősége nem szignifikáns (p=0.63)

az egyes sarzsokra párhuzamosaknak tekinthetjük az egyeneseket
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Predicted vs. Residual Values

Dependent variable: konc

(Analysis sample)
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a reziduumok menete nem mond ellent a linearitásnak
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Normal Prob. Plot; Raw Residuals

Dependent variable: konc

(Analysis sample)
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a normalitás nem teljesen megnyugtató
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A párhuzamos egyenesek közös tengelymetszetének vizsgálata

Univariate Tests of Significance for konc (nemlin_stab.sta)
Sigma-restricted parameterization
Effective hypothesis decomposition; Std. Error of Estimate: 2.174338

Effect
SS Degr. of

Freedom
MS F p

Intercept
lnho
sarzs
Error

346717.73 1 346717.73 73336.78 0.000000
178.63 1 178.63 37.78 0.000000
154.58 8 19.32 4.09 0.001606
165.47 35 4.73

a tengelymetszetek szignifikánsan különböznek 
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a legrosszabb (3. számú) sarzsra

Scatterplot of aktiv against lnho

nemlin_stab.sta

Include condition: sarzs=3

konc = 92.9149-1.8248*x; 0.9 Conf.Int.

-4 -3 -2 -1 0 1 2 3

lnho

80

82

84

86

88

90

92

94

96

98

ko
nc



Stabilitásvizsgálat 82

a párhuzamos egyenesek konfidencia-sávja szűkebb, mint az 
egyenkéntieké (a reziduális szórás szabadsági foka nagyobb)

a 3. sarzshoz számolunk konfidencia-sávot, de fölhasználva az 
egyenesek együttes illesztésekor kapott reziduális szórásnégyzetet

Scatterplot of multiple variables against lnho

Include condition: sarzs=3

 koncPRE1
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ln(ho+0. 05)=2.893 
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Scatterplot of multiple variables against lnho

Include condition: sarzs=3

 konc
 koncPRE1
 koncLCL1
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a mért koncentráció-pontok közül néhány az alsó konfidencia-sáv
alatt van
baj ez?
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az eredeti idő-skálával ábrázolva

Scatterplot of multiple variables against ho
Include condition: sarzs=3
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5. példa: Bomlástermék koncentrációja

bomlastermek.sta

Nemlineáris függvény

1
sarzs

2
honap

3
boml

1
2
3
4
5
6
7
8
9

10
11
12

5 0 0
5 3 0.17
5 6 0.23
5 9 0.25
6 0 0
6 3 0.15
6 6 0.21
6 9 0.24
7 0 0
7 3 0.12
7 6 0.19
7 9 0.21
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Scatterplot of boml against honap

bomlastermek.sta 3v*12c

 Include sarzs=5 
 Include sarzs=6 
 Include sarzs=7 
 Other 
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Graphs>Scatterplots
Mark selected subsets (alul)

másodfokú
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Nem jó, nem monoton (ez a polinom tulajdonsága).

Másodfokú polinom Scatterplot of boml against honap

bomlastermek.sta 3v*12c

boml = 0.0022+0.0563*x-0.0034*x^2; 0.9 Conf.Int.
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Hatvány-függvény
Statistics>Advanced Linear/Nonlinear Models>Nonlinear Estimation
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Model: boml=a*honap^b (bomlastermek.sta)
Dep. var: boml Loss: (OBS-PRED)**2
Final loss: .003286812 R= .98376 Variance explained: 96.778%

N=12 a b
Estimate
Std.Err.
t(10)
p-value

0.095779 0.414298
0.013931 0.076477
6.875286 5.417290
0.000043 0.000294

Ez jó, a meglévő mérési pontokra, de az extrapolálhatósága kérdéses. 

Model: boml=a*honap^b

y=(.09577941238091)*x^(.41429753098315)
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Predicted versus Residual Values
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Normal Probability Plot of Residuals
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Logaritmus-függvény

Ez is jó, extrapolálhatósági szempontből szimpatikusabb, csak a 0 
időpontban nem értékelhető ki (ln0=-∞). 

Scatterplot of boml against honap

bomlastermek.sta 3v*12c

boml = 0.0606+0.1847*log10(x)

 Include sarzs=5 
 Include sarzs=6 
 Include sarzs=7 
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Javított logaritmus-függvény

Statistics>Advanced Linear/Nonlinear 
Models/Nonlinear Estimation
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Model: boml=a+b*log(honap+0.05) (bomlastermek.sta)
Dep. var: boml Loss: (OBS-PRED)**2
Final loss: .005775438 R= .97128 Variance explained: 94.339%

N=12 a b
Estimate
Std.Err.
t(10)
p-value

0.12458 0.04321
0.00716 0.00335

17.39596 12.90943
0.00000 0.00000

Covariance Matrix of Parameter Estimates (bomlastermek.sta)
Parameter a b
a
b

0.000051 -0.000006
-0.000006 0.000011
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Model: boml=a+b*log(honap+0.05)

y=(.12457523368653)+(.04320877748911)*log(x+0.05)
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Model: boml=a+b*log(honap+0.05) (bomlastermek.sta)
Dep. var: boml Loss: (OBS-PRED)**2
Final loss: .005775438 R= .97128 Variance explained: 94.339%

N=12 a b
Estimate
Std.Err.
t(10)
p-value

0.12458 0.04321
0.00716 0.00335

17.39596 12.90943
0.00000 0.00000

Covariance Matrix of Parameter Estimates (bomlastermek.sta)
Parameter a b
a
b

0.000051 -0.000006
-0.000006 0.000011

sa, sb

sab
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1
sarzs

2
x

3
y

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15

5 0 0
5 3 0.17
5 6 0.23
5 9 0.25
6 0 0
6 3 0.15
6 6 0.21
6 9 0.24
7 0 0
7 3 0.12
7 6 0.19
7 9 0.21

12
18
24

1
sarzs

2
honap

3
boml

1
2
3
4
5
6
7
8
9

10
11
12

5 0 0
5 3 0.17
5 6 0.23
5 9 0.25
6 0 0
6 3 0.15
6 6 0.21
6 9 0.24
7 0 0
7 3 0.12
7 6 0.19
7 9 0.21

File>Open: Konfint4b.svb
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1
sarzs

2
x

3
y becsult

4
y also

5
y felso

6
y

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15

5 0 -0.00487 -0.02968 0.019947 0
5 3 0.172759 0.159695 0.185824 0.17
5 6 0.202354 0.187609 0.217099 0.23
5 9 0.219754 0.203598 0.23591 0.25
6 0 -0.00487 -0.02968 0.019947 0
6 3 0.172759 0.159695 0.185824 0.15
6 6 0.202354 0.187609 0.217099 0.21
6 9 0.219754 0.203598 0.23591 0.24
7 0 -0.00487 -0.02968 0.019947 0
7 3 0.172759 0.159695 0.185824 0.12
7 6 0.202354 0.187609 0.217099 0.19
7 9 0.219754 0.203598 0.23591 0.21

12 0.232125 0.214825 0.249424
18 0.249585 0.230518 0.268651
24 0.261985 0.241578 0.282392
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Scatterplot of multiple variables against x

bomlastermek.sta 6v*15c

 y becsult
 y also
 y felso
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Scatterplot of multiple variables against x

bomlastermek.sta 6v*15c

y becsult = Distance Weighted Least Squares
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 y felso

-2 0 2 4 6 8 10 12 14 16 18 20 22 24 26

x

-0.05

0.00

0.05

0.10

0.15

0.20

0.25

0.30



Stabilitásvizsgálat 104

Scatterplot of multiple variables against x

Function = 0.12458+0.04321*Log(x+0.05)
Function = 0.12458+0.04321*Log(x+0.05)

+2.228*sqrt(0.00005128+(Log(x+0.05))^2*0.00001120-Log(x+0.05)*0.00000594)
Function = 0.12458+0.04321*Log(x+0.05)

-2.228*sqrt(0.00005128+(Log(x+0.05))^2*0.00001120-Log(x+0.05)*0.00000594)
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K. Komka, S. Kemény: Effect of the uncertainty of the stability data on the 
shelf life estimation of pharmaceutical products, Periodica Polytechnica, Ser. 
Chem. Eng. 4841-52 (2004)

Becsülhetünk-e valamit előre?
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Matrixing: egy-egy vizsgálati időpontban csupán a vizsgálandó
minták egy részét teszteljük

A módszer alkalmazásának fontos követelménye, hogy az 
egymást követő vizsgálati pontokban a mintáknak mindig 
különböző részleteit vizsgáljuk meg. 

A módszer azon a feltételezésen alapul, hogy az adott időpontban 
vizsgált minták stabilitási tulajdonságai az összes minta stabilitási 
tulajdonságait reprezentálják.

Bracketing: minden vizsgálati időpontban csupán a szélső értékű
(pl. hatáserősség vagy csomagolási mód szerinti) mintákat 
teszteljük. 

A módszer azon a feltételezésen alapul, hogy a „közbenső” minták 
stabilitását jellemző tulajdonság-értékek a „szélső” minták 
stabilitását jellemző tulajdonság-értékek között helyezkednek el.
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Pl. a teljes terv 
3 hatáserősségre, 
hatáserősségenként 3 sarzsra, 
kétféle (pl. 90 és 100 tabletta/ flakon) csomagolásra, 
12 időpontban 
összesen 12*3*3*2=216 analízis
minden vizsgálandó körülmény-rendszerre (hőmérséklet és 
nedvességtartalom). 

Ez csökkenthető a bracketing és matrixing módszerével.

Fontos tudni, hogy az analízisek számának csökkentésével a lejárati 
idő kijelöléséhez használandó konfidenciasáv szélessége nő, tehát 
rövidebb lejárati időt kapunk.
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Csak bracketing: a középső hatáserősségű tabletták vizsgálatát 
mellőzhetjük. 
Így a 216 helyett 144 analízist írunk elő. 

Csak matrixing: 
az 1, 2., 3., 6. 9., 18., 24., 48. hónapoknál (8 időpontban) 
végzendő teljes terv (8*3*3*2=144 analízis) fele (72 analízis), 
a 0., 12., 36. és 60. hónapnál minden (4*3*3*2=72) analízist 
előírva, 
bevonva a kétféle csomagolást, háromféle hatáserősséget, 
(összesen 72+72=144 analízis) . 
Ennél a tervnél a csökkentés egyenletesen oszlik szét 
(kiegyensúlyozott terv). 
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  month 

Batch tabl./bottle 0 1 2 3 6 9 12 18 24 36 48 60 
A1 90 + + - - + - + + + + - + 
A2 90 + - + + - + + - - + + + 
A3 90 + - + + - + + - - + + + 
B1 90 + - + + - + + - - + + + 
B2 90 + - + + - + + - - + + + 
B3 90 + + - - + - + + + + - + 
C1 90 + - + + - + + - - + + + 
C2 90 + + - - + - + + + + - + 
C3 90 + - + + - + + - - + + + 
A1 100 + - + + - + + - - + + + 
A2 100 + + - - + - + + + + - + 
A3 100 + + - - + - + + + + - + 
B1 100 + + - - + - + + + + - + 
B2 100 + + - - + - + + + + - + 
B3 100 + - + + - + + - - + + + 
C1 100 + + - - + - + + + + - + 
C2 100 + - + + - + + - - + + + 
C3 100 + + - - + - + + + + - + 

 

Matrixing: nem minden időpontban végzik el az összes mérést
teljes: 0, 12, 36, 60, részleges: 1, 2, 3, 6, 9, 18, 24, 48

+ van analízis, - nincs analízis

Stabilitásvizsgálat 111

 
 az analízisek száma  
 azokban az időpontok-

ban, ahol nem hajtunk 
végre minden kísérletet 

azokban az időpontok-
ban, ahol minden 
kísérletet végrehajtunk  

összes 
kísérlet-
szám 

teljes terv a 0., 12., 
36. és 60. hónapnál 

72 72 144 

teljes terv a 0., 36. 
és 60. hónapnál, 1/3 
terv 

54 54 108 

teljes terv a 0., 36. 
és 60. hónapnál, 2/3 
terv 

108 54 162 

 

Változatok:
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A bracketing és matrixing kombinációja

Csak a két szélső hatáserősségre végeznének vizsgálatokat 
(bracketing), de ezeknél sem minden időpontban, hanem rész-
faktortervként (matrixing). 

A 12. hónapot nem tüntettem ki, de a 0., 36. és 60. hónapot igen 
(vagyis 9 időpontban lennének nem-teljes elemzések).
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Batch tabl./bottle 0 1 2 3 6 9 12 18 24 36 48 60 

A1 90 + + - - - - + - + + - + 
A2 90 + - - + - + - + - + - + 
A3 90 + - + - + - - - - + + + 
C1 90 + - + + + + - + - + + + 
C2 90 + + + - + - + - + + + + 
C3 90 + + - + - + + + + + - + 
A1 100 + - + + + + - + - + + + 
A2 100 + + + - + - + - + + + + 
A3 100 + + - + - + + + + + - + 
C1 100 + + - - - - + - + + - + 
C2 100 + - - + - + - + - + - + 
C3 100 + - + - + - - - - + + + 

 

+ van analízis, - nincs analízis
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Koncepcionális probléma

Az adatok számának növelésével a konf. sáv szűkül.
Ha n→ ∞, 0 a szélessége

Alsó konf. határ µ-re:

nztL σββ αα −+= 0

( )
ξσ

ξξ E
z

−=








 −≥=






 −−≥
n

z
zP

tL
zP αα

σ
ββ0 ha n→ ∞ ( ) 5.00 =≥zP

A tabletták 50%-a lenne a határ fölött.
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„Az összes jövőbeli sarzsra...”→ a sarzs véletlen faktor

A Guideline „igazi” függvényt feltételez, ennek a 
konfidencia-sávját számoljuk ki. 

A valóságban inhomogenitás van, emiatt a tabletták 
zöméről (pl. 99%-áról) lenne értelme beszélni →

tolerancia-tartomány.


